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Technical Support
If you have difficulties using Express Animate Animation Software please read the applicable 
topic before requesting support. If your problem is not covered in this user guide please view 
the up-to-date Express Animate Animation Software Online Technical Support at 

www.nchsoftware.com/animation/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to Express Animate Animation Software, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/animation/support.html
www.nch.com.au/suggestions/index.html
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About Express Animate
Express Animate is a motion graphics application developed by NCH Software. It can be used 
to animate, edit, and compose media in 2D space.
Features  
● Layer-oriented: Each individual media object occupies its own layer.
● Import and organize video footage.
● Load a wide variety of video file formats, including AVI, MOV, MP4, and WMV.
● Create, arrange, and composite layers in a composition. Create one or more compositions.
● Create and animate vector shapes and masks.
● Apply impressive visual effects.
● Create unique animated text effects.
● Group multiple layers within the same composition by creating a parenting chain.
● Dummy objects let you get better control of your animation.
● Save the resulting movie to a file, upload it to YouTube, or burn it to DVD.
System Requirements  
Operating system Windows XP SP2 / Vista / 7 / 8 / 8.1 / 10
CPU  Intel Core 2 Duo 2.0 GHz 

or 
AMD Athlon 64 X2 5000+ 

RAM 2 GB
Display 1024 x 768
Sound card Windows compatible sound card
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Getting Started
1. Workspaces and panels The main interface of Express Animate consists of several 

panels. Panels are organized in the main application window in an arrangement called a 
workspace. Three of the most commonly used panels are the Objects Panel, Canvas 
Panel, and the Composition Panel. 

The Objects Panel allows you to change the active composition and displays the objects' 
hierarchy within the active composition. You can select and delete objects from the active 
composition or parent one object to another using drag and drop. 

The Composition Panel is used for ordering objects in relation to each other and for timing 
adjustments. 
Everything that is visible in the composition at the current time marker are displayed in the 
Canvas Panel. 
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● Objects Panel  

● Canvas Panel  

● Composition Panel 
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2. Adding Media Objects  Load video files (.avi, .mov, etc.), audio files (.aac, .mp3, etc.), or 
image files (.jpg, .png, etc.) using one of the following ways: 

● Drag and drop one or more files from File Explorer or the desktop into the Canvas Tab.
● Select File -> Load Media Files... 
● Click the Load Media  tool bar button 

3. Arranging objects on Canvas  When you place objects on the canvas their position on 
the screen is described with coordinates. When you select an object you can see its 
Position property inside the Composition Panel. 

The values for these coordinates are in 
pixels. The first value, called X, represents position on the horizontal axis and the second 
value, called Y, represents position on the vertical axis. In the example X is -3.3 and Y is 
-10.4 

● The Anchor value represents the position of the anchor point in Object Coordinate 
Space, where the X and Y coordinates are relative to the Object's origin (0,0), which is 
fixed at the upper left corner of the Object. 

● The Position value represents the position of the anchor point in the Composition 
space, where the X and Y coordinates are relative to the origin (0,0), which is fixed at 
the upper left corner of the Canvas. 

Move objects by dragging in the Canvas Panel 
● Select one or more objects, and then drag the selected objects with a mouse.
● When you move an object by dragging it on canvas, the position property gets 

automatically adjusted according to the objects' new position as you drag.
Move objects by directly modifying the Position property 
1. Select one or more objects.
2. Find the Position property in the Composition Panel for the objects.
3. Modify the X and Y Position properties.
Move objects with arrow keys 
1. Select one or more objects.
2. To move selected objects one pixel left, right, up, or down, press an arrow key.

4. Arranging objects on the Timeline 
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The timeline control is located at the top of the Composition Panel and is used to set the 
current position of the active composition. The timeline works with timecodes (see 
SMPTR timecode). A frame is the minimum unit of measure on the timeline. 

Selected objects are indicated with a blue highlight in the Composition Panel and is 
automatically scrolled to the top of the panel to ensure that it is visible in the panel. 
The colored bars in the Composition Panel visually represent the objects' duration. The 
beginning of the duration of an object is its In point, and the end is its Out point. The 
duration is the span between the In and Out points, and the bar that extends from the In 
point to the Out point is the object duration bar. 

To move an object in time, drag the object duration bar to the left or to the right. By default 
object duration bars snaps to significant points in time (such as bookmarks, or the start or 
end of the composition). You can turn Snapping off by pressing and holding the Shift 
keyboard key or by clicking on the Snap icon 

located on the top of the Composition Panel. 

5. Previewing the Composition 
All items visible at the current time marker are displayed in the Canvas Panel. 
You can adjust the Preview Quality  from a drop down box at the bottom of the Canvas 
Panel. Hint: Decrease the preview quality to improve rendering performance. 
Preview Playback Controls are located at the bottom of the Canvas Panel. Use Go to 
start, Go to end, Step back, and Step forward buttons to change the current timeline 
position. Click Play button to start the preview playback of the active composition. 

There are 3 different playback modes which can be selected using a drop down menu next 
to the play button: 
1. Play every frame - Every frame of the composition is displayed according to the 

composition framerate. Audio is not available in this mode.
2. Real-time playback - Composition is played back in real time. Frames are dropped if 

necessary to make sure video and audio are in sync during playback.
3. Real-time playback of cached frames - Composition frames are cached starting from 

the current timeline position and until the preview cache is filled up completely. After the 
caching is done, real-time playback of the cached segment is performed in a loop.

6. Trimming objects' duration 
To trim an object's duration is to modify its In or Out point so that the object has a different 
duration. By dragging either end of a layer duration bar you can trim the object's duration or 
extend it. Trimming object's duration does not alter video footage or original source files. 

You can extend image, text and shape objects for any duration, extending their In and Out 
points out past their original times. 
When you trim video or audio file object a pale bar represents the frames of the footage 
that you are excluding from the composition. You can choose which frames are played 
within a trimmed duration by dragging the slip-edit bar. 

By default, new compositions have the duration of 30 seconds. Image, shape, and text 
objects have the default duration of 5 seconds, and the duration of video and audio objects 
is based on the duration of the original file. 

To change the duration of a composition click Composition settings button next to the 
compositions list in the Objects Panel or click the Change composition duration button 
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located on the top of the Composition Panel. 

7. Object properties in the Composition Panel 
Each object has properties, many of which you can modify and animate. Every object has a 
Transform property group that includes Position and Opacity. By adding masks or effects to 
an object, you can create additional property groups for the object. 

To expand or collapse a property group, click the collapse/expand button to the left of the 
object name or property group name. 
Set a property value 
To change a property value click the highlighted value, enter a new value, and then press 
Enter. Or you can place the cursor over the highlighted value, press and hold the left 
mouse button, and drag to the left or right to increase or decrease the value. 

8. Animating a property  
Any property that displays a little diamond icon can be animated - that is, changed over 
time. To start animating a property click the 'New key' diamond button. Then move the 
timeline cursor to a new position and change the property value. 

9. Parent and child objects  

Use the Objects Panel to assign objects as parents to other objects. This is useful when 
you want to animate several objects at the same time. 
Select an object in the Objects tab and drag it on top of another object. The transform 
properties of the child object become relative to the parent object instead of to the 
composition. For example, if a parent object moves 5 pixels to the right of its starting 
position, then the child object also moves 5 pixels to the right of its position. 

Parenting affects all transform properties except Opacity, Position, Scale and Rotation. 
An object can have only one parent, but an object can be a parent to any number of objects 
in the same composition. 
You can animate child objects independent of their parent objects, which won't be visible 
when rendering a composition. 

10. Adding another composition as a child object 
Other compositions may be included within the composition to help with the creation of 
larger, more complex compositions out of simpler ones. 
To add another composition to the currently selected composition, select the new 
composition from the Composition button 
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on the Object tab. The child composition may be parented to any object within 
the current composition and acts just like any other child object within the composition, so 
can be scaled, rotated and moved just like any other object. 

To edit the child composition, select the child composition from the composition pull-down 
at the top of the Objects Panel. The child composition can be modified separately of any 
composition that it may be a child of, all changes to the composition will be reflected in the 
any composition that it has been included in. 

11. Creating shapes and masks  
Creating shapes To create a shape object click a shape (e.g. Rectangle, Ellipse, or 
Custom Shape) button on the tool bar. To select the type of the shape use the drop down 
menu to the right of the tool bar button.
● To draw a rectangle , click the rectangle tool bar button, move your mouse over the 

canvas, click and hold the left mouse button and drag diagonally.
● To draw an ellipse, click the ellipse tool bar button, move your mouse over the canvas, 

click and hold the left mouse button and drag diagonally.
● To draw a custom shape: 

1. With the Custom Shape tool bar button selected, click in the Canvas where you 
want to place the first vertex.

2. Click where you want to place the next vertex to create a straight segment
3. By continuing to click, you create a path made of straight line segments connected 

by corner points.
4. To create a curved segment, click and drag the direction line handle to create the 

curve that you want.
5. To finish editing press the Enter or Escape key

Creating masks  A mask is used for isolating an area of an object to make that part of the 
object transparent to the objects beneath it. You can create one or more masks for each 
object in a composition to cut out certain parts of an image, so the objects, positioned in the 
composition below the selected object, will show through. Masks can be animated over 
time, for example to follow a moving object in a video. 

Editing masks is similar to editing shape objects. 
To create a new mask select an object and click on the Mask icon on the main toolbar, or 
choose New Mask from the right-click menu in the Composition Panel. A Mask property 
group will appear in the objects' list of properties. With the Mask property selected, click 
and drag on yellow vertices on the canvas to change the shape of the mask. Hold Ctrl key 
when selecting a vertex to edit a curve for this vertex. Right-click on the Mask to add new 
vertices. 

12. Applying Effects  
Every object can have one or more effects applied to it. 
To apply a visual effect to a selected object click the Effect toolbar button and select a 
Video effect from a drop down list. 
To apply a sound effect right-click an audio object in the Composition Panel and select an 
effect from the Sound->New Effect menu. Alternatively you could apply an effect to 
selected object by selecting Object->Sound Effects  from the main menu. 
After you've applied an effect to an object, a new property group is created for that object in 
the Composition Panel. Some effect properties can be animated. 
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See: Full list of effects  
13. Blending mode 

It is possible to control the way an object blends with objects beneath it, or use an object as 
a stencil or silhouette. 
The default blending mode is Normal . In this mode the result color is the color of the top 
object, the underlying color is ignored. 
To change the oBject's blending mode right-click an object and select Blending Mode  
from a context menu. 
See: Full list of blending modes  

14. Animation Curve Editor  
Curve Editor control is used for precise control over the way an object property is animated. 
To activate the curve editor select a property of an object (e.g. Position, Scale, etc) in the 
composition panel and click Open the curve editor button 

located on the top of the Composition Panel. Drag animation keys and their control 
points to modify the interpolation curve and control the way the property is animated. To 
change the interpolation type right-click an animation key and select Linear or Bezier Curve 
interpolation from the context menu. 

15. Rendering video 
Once you have finished editing your project, save or upload a video to share it with other 
people.
1. Click the Save Video button on the tool bar. The Video Output Setup dialog will appear.
2. Select the destination device and format you want your project to be built for by clicking 

on the picture.
3. You can adjust the settings for the format you have chosen if you want to. There are 

help pages for each destination type. Access them by clicking the Help button at the 
bottom of the Video Output Setup dialog.

4. Click the Create button at the bottom of the Video Output Setup dialog.
5. After the export process completes the video will be saved into the file you specified.
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16. Exporting to HTML5  
The final video may be published as a HTML5 web page that you can include on your own 
web site.
1. Click the Save HTML5  button on the tool bar. The HTML5 Export Parameters dialog 

will appear.
2. Select the output folder and resolution you want your project to be saved with.
3. Click the Save HTML5 button at the bottom of the HTML5 Export Properties dialog.

See the Sample Project for a working example of some of the features that are available. 
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Flickr
Flickr 
You can open the Flickr export dialog via one of the following methods: 
● From the Home  tab on the Toolbar. Click the Save Video drop down button. Select the Fl

ickr  option. 
● From the File tab on the Toolbar. 

Click the Save Video... menu item and in the wizard that opens, select the Upload, then 
the Flickr option. 

Once reaching the Flickr export dialog, you can choose assorted settings that will be applied to 
the exported project. 
After making your selections click on Create, to being the export and upload process. 
If required, the Flickr Authorization  dialog will appear and your web browser will open, 
allowing you to log in to the service. 
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YouTube
YouTube  
You can open the YouTube export dialog via one of the following methods: 
● From the Home  tab on the Toolbar. Click the Save Video drop down button. Select the Y

ouTube  option. 
● From the File tab on the Toolbar. 

Click the Save Video... menu item and in the wizard that opens, select the Upload, then 
the YouTube  option. 

Once reaching the YouTube export dialog, you can choose assorted settings that will be 
applied to the exported project. 
After making your selections click on Create, to being the export and upload process. 
If required the YouTube Authorization dialog will appear. Login to your YouTube Account, 
and follow the prompts to allow the application to access your online profile. 
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Google Drive
Google Drive  
You can open the Google Drive export dialog via one of the following methods: 
● From the Home  tab on the Toolbar. Click the Save Video drop down button. Select the G

oogle Drive  option. 
● From the File tab on the Toolbar. 

Click the Save Video... menu item and in the wizard that opens, select the Upload, then 
the Google Drive  option. 

Once reaching the Google Drive export dialog, you can choose assorted settings that will be 
applied to the exported project. 
After making your selections click on Create, to being the export and upload process. 
If required the Google Authorization dialog will appear. Login to your Google Account, and 
follow the prompts to allow the application to access your online profile. 
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Dropbox
Dropbox 
You can open the Dropbox export dialog via one of the following methods: 
● From the Home  tab on the Toolbar. Click the Save Video drop down button. Select the D

ropox  option. 
● From the File tab on the Toolbar. 

Click the Save Video... menu item and in the wizard that opens, select the Upload, then 
the Dropbox option. 

Once reaching the Dropbox export dialog, you can choose assorted settings that will be 
applied to the exported project. 
After making your selections click on Create, to being the export and upload process. 
If required the Dropbox Authorization dialog will appear. Login to your Dropbox Account, and 
follow the prompts to allow the application to access your online profile. 
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Vimeo
Vimeo 
You can open the Vimeo export dialog via one of the following methods: 
● From the Home  tab on the Toolbar. Click the Save Video drop down button. Select the Vi

meo  option. 
● From the File tab on the Toolbar. 

Click the Save Video... menu item and in the wizard that opens, select the Upload, then 
the Vimeo option. 

Once reaching the Vimeo export dialog, you can choose assorted settings that will be applied 
to the exported project. 
After making your selections click on Create to begin the export and upload process. 
If required, the Vimeo Authorization dialog will appear and your web browser will open, 
allowing you to log in to the service. 
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.

There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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Flickr Authorization
Express Animate can make it easy and convenient to upload your photos or videos to Flickr. 
However, it needs your permission before you use it. 
If you click the Authorize... button, the Flickr website will open in your web browser. If the 
Flickr website shows a login page, please log in. The website will then ask if you want to link 
Express Animate to your Flickr account. Please click OK, I'll authorize it. The website will 
then show a nine digit verification code. Please type or copy and paste the code from the 
website into Express Animate and click Continue. 
Flickr Authorization 
If Express Animate has the authorization of a Flickr's user, the Authorize... button will be 
disabled and the Remove Authorization  button will be enabled so that you can delete the 
authorization. Otherwise, you click the Authorize... button to authorize Express Animate for 
uploading photos or videos to Flickr. 

20



Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give Express Animate authorization to upload to Google Drive 
and/or YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize Express Animate to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in Express Animate. 
5. Click Ready to confirm that authorization is complete. 
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.

2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.

3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.

4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.

5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.

6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.

7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.

9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.

A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.

A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.

B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.

D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Sample Project - The Sample Project
The sample project shows some of the features that may be added to your animation. 
You may use the sample to try out features and to experiment to see how changing object 
properties affects the animation. 
To load the sample project select Open Sample Project from the Welcome to Express Animate 
dialog when the program first opens or alternatively select File -> Open Sample Project. 
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1. Main Composition
The main composition is made up four objects, three of which are animated, the other is a 
child and is animated by its parent. 
● The "This text appears" Text  object has been animated so that it will change its Scale 

as well change its Opacity over time. It starts of with an opacity of 0% and a scaling of 
100% up until the 2 second mark then by the 4.17 second mark the opacity is 100% 
and the scaling is 113% 

The effect of this is the text will appear to fade into view between the 2 second mark 
and 4.17 seconds as well as grow slightly in size. 

● The "Sun" Shape  object is made up by an Ellispe object with the proportions of a circle 
and the "Rays" child object which is another Ellispe which has been modified by adding 
extra vertices which were moved to give the rays effect. 

The Sun object has been animated so that it slowly rotates around its own center, this 
animation also applies to the child "Rays" object. 

● The "Clouds" object is the Clouds Composition which has been animated so that it 
scrolls from right to left over time. Since the Clouds Composition is wider then the 
parent composition it will not be fully visible at any one time as it will effectly be masked 
by the size of the parent composition. 

The main composition's background is a solid blue color. This could be changed to be a 
gradient so that it is lighter towards to top of the frame to give a more sky like coloration. 
Try: 

Change the background to a gradient click on the Composition Settings button next to 
the composition name on the Objects Panel, open the Background tab and select the 
Gradient radio button. Move th Direction arrow so that it points vertically from bottom to 
top, then change the color of the top Stop to be a medium blue and the top Stop to be a 
lighter blue. Click OK to accept the change. 

2. Clouds Composition
The clouds composition is made up of two sets of clouds made up of 10 small and 14 large 
clouds, each of which were created as Custom Shape objects. They are grouped into small 
clouds and large clouds by making them the children of either the 'Small clouds' or 'Big 
clouds' dummy objects. The two dummy objects are a way to create simple groups of 
objects. 

The background fill color is ignored when it is included as a child composition by the main 
composition. 
The clouds composition in this sample does not contain any animation timings itself, it is 
merely a static image which is animated by the main composition. 
Try: 

Add animation keys to either the small clouds or the big clouds so they move at a 
different rate. See how it looks when you play the Clouds composition by itself and how 
the main composition now looks. 

The order of the layers is controlled by the positions of the objects in the Composition Panel, 
objects higher in the order are on top of the lower ordered objects. 
In this sample the "Sun" object is made up of two objects, a yellow disk and the "Rays" shape 
object. 

The "Sun" is higher in order then the "Rays" 
object so that it sits on top of the Rays. 
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The "Clouds" object is the lowest object in the order so that they are beneath all the other 
objects. 
Try: 

Change the order so that the "Clouds" layer is above the the "Sun" layer so that the clouds 
appear nearer than the Sun. 
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Cloud Services - Download/Upload
Open from Cloud 
Express Animate allows you to open files from Dropbox, OneDrive, or Google Drive. Dropbox, 
OneDrive and Google Drive are cloud-based storage services that let you upload, store, 
access and share your files from anywhere. For Dropbox the first 2 GB, for OneDrive the first 5 
GB and for Google Drive the first 15 GB of storage are free, but additional storage packages 
are available for a monthly fee. 

Using 'Download Project File from Cloud...' option under the 'File' menu of Express Animate, 
you can choose one of the above cloud services. After authenticating with your account, you 
will be able to navigate through the folders to select the desired file and open it in Express 
Animate. It should be noted that Dropbox only allows you to use the 'Apps\ExpressAnimate' 
folder with Express Animate. 

Save to Cloud 
Express Animate allows you to save your Express Animate projects to different cloud services 
including Google Drive, Dropbox, OneDrive. 
Using 'Upload Project File to Cloud...' option under the file menu, you can choose any of the 
above cloud services. You can navigate through the folders and type in a name for your file, 
and click on 'upload'. 

28



Finalize a Project - Saving a Video
Once you have finished editing your project, you can save or upload a video to share it with 
others.
Select File -> Save Video, or click the Save Video button on the tool bar. The Export Video 
wizard will appear to guide you through the video export process. 
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Finalize a Project - Sharing a Video
Sharing a Video 
You can share or upload your project to any of the following services: 
● YouTube 
● Flickr 
● Google Drive 
● Dropbox 
● Vimeo 
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Finalize a Project - Burning a Video
Burning a Video 
The kinds of media to which you can Burn your project are DVDs, and Blu-rays . 
You are also able to burn your project to this media in two different ways. 
● Video Discs 

The project is exported in the format by which consumer devices will be able to play your 
video. 
That is, as a normal DVD or Blu-ray. 

● Data Discs 
The project will be exported as a file. Which will appear on the DVD or Blu-ray you are 
burning it to. 
Unlike a normal video disc, some consumer devices may not be able to play your video, or 
you may need to navigate device specific menus to find, and play them. 
This is similar to inserting a USB device into your media player, if it supports that feature. 

You can begin the Burning process by selecting a DVD  or Blu-ray  options from one of the 
following locations: 
● From the Home  tab on the Toolbar. Click the Save Video drop down button and select 

appropriate menu item. 
● From the File tab on the Toolbar. 

Click the Save Video... menu item and in the wizard that opens, select Disc , then the 
required disc types. 

After making your selections on the Choose Disc Settings dialog, click Create, and follow 
any onscreen prompts. 
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Finalize a Project - Backing Up or Moving a 
Project to Another Computer
A project file only stores the paths of media files (including video, audio, and image files), not 
the entire file contents. When a project file is loaded, it attempts to find and load the media files 
using those file paths. If a media file has been moved or deleted, or the project file alone has 
been copied or moved to another computer, Express Animate will not be able to find the 
original media files. 

To back up a project and all its media files, or to move a project and all its media files to 
another computer, select File -> Back Up Project Files to Folder. This will save a new copy 
of the project (.apj) file in the selected folder, and all media files used in the project will also be 
copied into the same folder. This entire folder can then be saved to backup media, copied or 
moved to another computer. 
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Editing - Animation
Animating an object is done by changing a property over time, which leads to a visual 
transformation. 
In order to create an animation, it is necessary to set key frames (keys) for a specific property 
on the timeline and set the value of the property for each key. A key can be added in one of the 
following ways: 

1. Click on the diamond to the left of the property name. 

2. Use the right-click menu on the timeline. 

In order to see an animation or visual transformation of the object, you will need to add two or 
more keys with different values and at different points on the timeline to a property. 
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Move the cursor to a new position on the timeline using the following methods: 
1. Click the mouse on the timeline at the new position. 

2. Enter a new time in the timeline position edit box. 

To add the 2nd key and subsequent keys after this, you can use one of the following methods 
after moving the cursor: 

1. Click on the diamond to the left of the property name. 
2. Use the right-click menu on the timeline. 
3. Change the value of the property in the property panel. 
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4. Edit the object on your canvas. For example, to animate the position property, click and 
drag the object on the canvas 

After adding keys using the methods above, a visible transformation or animation will be added 
to the object. The animation begins with the first key and ends with the last key. Use multiple 
keys and properties to create more complex animations. 

To watch tutorials on creating characters and animations, please visit our tutorial page . 
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Editing - Bookmarks
You can add bookmarks to your timeline to separate the timeline into sections. Timeline cursor 
and objects will snap to these bookmarks. 
Adding a Bookmark 

To add a bookmark right-click the timeline at the point you wish to add a bookmark and 
select Set Bookmark. 
The Edit Bookmark  dialog will open. Enter the bookmark's name and choose the color you 
would like your bookmark to be by clicking the color sample, then click OK. 
Editing Bookmarks  
To change the name or color of a bookmark, right-click it and select Edit Bookmark...  The 

 dialog will open. 
Removing Bookmarks 
To remove a bookmark, right-click it and select Remove Bookmark. 
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Editing - Composition
Composition Panel 

To expand or collapse a property group, click the collapse/expand button to the left of the 
object name or property group name. 
Set a property value 
To change a property value click the highlighted value, enter a new value, and then press 
Enter. Or you can place the cursor over the highlighted value, press and hold the left mouse 
button, and drag to the left or right to increase or descrease the value. 

Animating a property  
Any property that displays a little diamond icon can be animated - that is, changed over time. 
To start animating a property click the 'New key' diamond button. Then move the timeline 
cursor to a new position and change the property value. These animation positions are called 
'keys'. You may skip to the previous key in the timeline with the '<' icon and to the next key with 
the '>' icon. 
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Animation Curve Editor
Curve Editor control is used for precise control over the way an object property is animated. To 
activate the curve editor select a property of an object (e.g. Position, Scale, etc) in the 
composition panel and click Open the curve editor button 

located on the top of the Composition Panel. Drag animation keys and their control points 
to modify the interpolation curve and control the way the property is animated. To change the 
interpolation method for a key right-click the animation key and select either Linear or Bezier 
Curve interpolation from the context menu. 

Keys are added with the default Linear interpolation curve which means that property will 
transistion at a consistant rate to the next key value. With the Bezier interpolation curve you 
are able to modify the rate of change between keys, so for example the rate of change starts 
off slowly then towards the end it quickens. 

As each key has its own interplation method you may use a mixture of methods along the 
timeline, with somes keys using Linear and others using Bezier curves. 
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Editing - Composition Tools
Composition controls toolbar located on the top of the Composition Panel.
● Scratch 

- Enable/Disable timeline sound scrubbing.

● Snap 

- Enable/Disable object composition duration snapping.

● Curve Editor 

- Open the curve editor for the selected animation keys.

● Duration 

- Change the composition duration.
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Editing - Composition Properties - Video
This dialog is used to modify the parameters of a composition. 
● Name - Select a name to use for the composition source. 
● Aspect Ratio - Select composition proportions. 
● Framerate  - Select the number of frames per second in this composition. 
● Duration - Set the timecode for the maximum duration for this composition. The actual 

content duration can be shorter and is determined by the objects placed on the 
composition. 
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Editing - Composition Properties - Background
This dialog is used to choose the fill color or gradient for the background. 
Select the fill style: 
Click either the Solid, Gradient or Pattern  radio button to select the fill style. 
No Background  
The background will be set transparent. The transparent background will be filled with the 
checkerboard. 
Solid 
The background will be filled with a solid color. The current color will be shown in the color box 
next to the radio option. 
Click on the color box to change the color. 
Gradient 
The background will be filled with a gradient. 
Select either the Linear or Radial in the drop-down list to set the gradient type. 
The Direction box lets you change the direction, start and end points of the linear gradient. 
The direction can be changed by moving the square dot and/or the arrow head. 
The Stops  bar lets you control the stop points of the gradient. 
● Click on one of the stop points (little triangles on the right side of the bar) to select the stop 

point.
● Drag the stop point to move it.
● Right-click on the stop point to delete it or press the Remove  button to delete the selected 

stop point. 
● Click on the Stop Point  color box to change the color of the selected stop point. 
Pattern  
The background will be filled with the selected pattern available on the drop down selection. 
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Editing - Full list of effects
Video Effects  Every object can have one or more effects applied to it. 
● Black and White  - When applied, the image will appear black and white. Also known as 

gray-scale. For partially desaturating colors, use the Saturation effect instead.
● Sepia - Tints the image with a sepia color.
● Negative  - Every color is replaced with its negative color, like a film negative.
● Noise - Random pixels are drawn on top of the image. The higher the intensity, the more 

noise is added, and less of the original image is visible.
● Brightness - Applies brightness, contrast, and/or gamma to the image.

For brightness: Negative values give a darker image. Positive values give a brighter image.
For contrast: Negative values give lower contrast, causing dark areas to appear brighter 
and bright areas to appear darker. Positive values give higher contrast, causing dark areas 
to appear darker and bright areas to appear brighter.

For gamma: The value specifies non-linear gamma correction. Values less than 1 give a 
darker image. Values greater than 1 give a brighter image.

● Edge Detection - Finds and highlights the edges of objects in the frame.
● Posterize  - Reduces the apparent number of colors in the image, changing gradients into 

flat areas of color.
● Pixelate - The higher the coarseness value, the larger the size of the blocks used to render 

the image, and the lower the resolution appears.
● Blur / Sharpen - Negative values cause edges in the image to be sharpened. Positive 

values cause the image to be smoothed. Also known as blurred or softened.
● Saturation - Negative values cause the colors to be desaturated, where the minimum 

value gives a black and white image. Positive values cause the colors to be over saturated.
● Hue - Shifts the hue of every color in the image by the specified percentage, giving 

unnatural colors.
● Temperature  - Used to correct colors in video or images taken with incorrect white 

balance. Negative values make the image cooler. Positive values make the image warmer.
● Tint  - Tints the image with an RGBA (red / green / blue / alpha) color value. The Intensity 

slider changes the alpha.
● Two-Tone  - The brightest half of the pixels are converted to one color while all the rest are 

converted to another color.
● Tiles - Makes the image look like it is made of rectangular tiles. The number of tiles and 

the spacing between tiles can be changed.
● Green Screen  - Also known as "green screen" or "chroma keying".

Green screen is the process of removing a selected color from an image. For example, to 
show an actor standing in front of a computer generated background, the footage of the 
actor can be shot against a green screen. The background can then be removed with the 
green screen video effect to reveal another clip underneath which will provide the new 
background.

● Special Effects:  (Balloon, Snow and Snowflakes)
● Balloon - Add balloons into an image. Color and number of balloons per second can be 

set. Other parameters include screen time, wobble amplitude and frequency, scale and 
opacity.

● Snow - Add snow into an image. Parameters like number of snow per second, screen 
time, distance variance, fuzziness and glowiness can be set.

● Snowflakes  - Add snowflakes into an image. Parameters like number of snowflakes per 
second, screen time, sway frequency and amplitude, spin speed and variance, glowiness 
and distance variance can be set.
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Sound Effects
● Amplify - Increases the loudness (or volume levels) of the selected object. The volume is 

entered in percent (100 being no change, 50 being -6dB softer or 200 being +6dB louder).
● Chorus - Makes one voice or one instrument sound like 3 voices or instruments by playing 

the original with variably delayed and slightly pitch changed copies of the original.
● Compressor - A Dynamic Range Compressor limits the volume levels of a sound 

recording so that it stays within a certain loudness range.
An example of where it is used is in TV broadcasting, where it ensures that the volume 
levels of ads are perceived as being louder than the television program itself (without any 
change in the actual broadcast volume).

The "Threshold" setting works by detecting when the sound recording volume exceeds a 
defined decibel level. It then gradually attenuates the sound to bring it down below the dB 
level, and does it in such a way that the listener will not be aware the attenuation is 
occurring.

The "Ratio" setting limits the amount the volume level of the recording increases at any one 
time. If, for example, you wanted the volume levels of a recording to only increase by at 
most 1/4 of the amount they would normally increase, then this would correspond to a 
Ratio of 4:1. So if the recording volume level increased by 8dB, then you would only hear a 
2dB volume increase.

The "Limit" setting defines at what maximum decibel level the sound recording will be 
allowed to rise up to. So if, for example, the Limit was set to 0dB, then you will never hear 
the volume level of the recording get louder than 0dB. The Limit setting has similarities to 
the Threshold setting, but the main difference is that the Threshold does allow sounds to go 
above the defined decibel level (for a short time), whereas the Limit does not.

You will find that the minimum Limit volume you can set is the same as the maximum 
Threshold value. This basically means that, in any situation, the sound will start to 
attenuate at the threshold level, but will never be heard louder than the limit. 

● Distortion  - Adds distortion to sound. Degree of distortion is measured in percents. Top 
Line Level determines the level where the distortion kicks in.

● Echo - Repeat the sound after a specified short time.
● Flanger  - Similar to the phaser, except that the delay is slowly modulated over time. You 

specify the starting delay time, the frequency of modulation, the depth of modulation and 
the wet dry gain (100% for wet, 0% for dry).

● High Pass  - A high-pass filter (sometimes called a low cut filter) removes all low 
frequencies below a specified Hz. This is useful if you want to make your recording sound 
'clearer' or less 'muddy'. It is very usual to use a high-pass filter of about 300Hz on all voice 
recordings to improve intelligibility.

● Reverb - Reverb is many small reflections of the sound that come after a set time. It 
usually occurs when someone is speaking in a room, hall etc. More reverb is called wet, no 
reverb is called dry.

● Pan  - Fades the audio between the left and right channels.
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Editing - Full list of blending modes
Blending Modes  
● Normal  - The result color is the object color. This mode ignores the underlying color. This 

is the default mode.
● Dissolve - The result color for each pixel is either the object color or the underlying color. 

The probability that the result color is the object color depends on the opacity of the object. 
If opacity of the object is 100%, then the result color is the object color. If opacity of the 
object is 0%, then the result color is the underlying color. 

● Dancing Dissolve - Same as Dissolve, but each frame uses a new random seed, so the 
result varies over time. 

● Darken - For each color channel selects the darker of the object color channel value and 
the underlying color channel value. 

● Multiply - For each color channel, multiplies object color channel value with underlying 
color channel value and divides by 255. 

● Lighten  - For each color channel selects a lighter of the object color channel value and the 
underlying color channel value. 

● Screen  - Multiplies the complements of the channel values, and then takes the 
complement of the result. 

● Overlay - Does Multiply or Screen  depending on whether or not the underlying color is 
lighter than 50% gray. Preserves shadows and highlights. 

● Stencil Alpha  - Creates a stencil using the alpha channel of an object. 
● Stencil Luma  - Creates a stencil using the luma values of an object. The brighter the 

pixels the more opaque they are. 
● Silhouette Alpha  - Creates a silhouette using the alpha channel of an object. 
● Silhouette Luma - Creates a silhouette using the luma values of an object. The brighter 

the pixels of an object the more transparent they are. 
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Editing - Object Fill
This dialog is used to choose the fill color or gradient for the selected shape object. 
Select the fill style: 
Click either the Solid or Gradient radio button to select the fill style. 
Solid 
The shape will be filled with a solid color. The current color will be shown in the color box next 
to the radio option. 
Click on the color box to change the color. 
Gradient 
The shape will be filled with a gradient. 
Select either the Linear or Radial in the drop-down list to set the gradient type. 
The Direction box lets you change the direction, start and end points of the linear gradient. 
The direction can be changed by moving the square dot and/or the arrow head. 
The Stops  bar lets you control the stop points of the gradient. 
● Click on one of the stop points (little triangles on the right side of the bar) to select the stop 

point.
● Drag the stop point to move it.
● Right-click on the stop point to delete it or press the Remove  button to delete the selected 

stop point.
● Click on the Stop Point  color box to change the color of the selected stop point.
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Editing - Object Properties
Properties described in this section are presented for objects in the Composition Panel. 

● Mute 

- Enable/Disable sound of the object with presented audio. 
● Visibility 

- Show/Hide the object on the canvas and final video. 
● Solo 

- Enable/Disable solo mode for the object. Depending on the type of object, it has the 
following effects: 
● Audio file  - imposes mute on all other objects. 
● Video file  - hides and imposes mute on all other objects. 
● Other types - hides all other objects. 

● Lock 

- Enable/Disable possibility to change such properties of the object as Position, Rotation, 
etc. Also if lock is enabled the object becomes non-selectable. 

● Parent assignment  

- Allows to assign a parent object or remove it. 
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Editing - Preview Grid
Grid 
The grid is used for more accurate placement and alignment of objects on the canvas.
The size of the grid cells can be changed in the Options dialog. Increase the value of the Cell 
Size for larger grid cells and decrease the value of the Cell Size for smaller grid cells. 
To toggle the grid view on/off, click on the grid icon beneath the preview. 

Preview 
Grid Snapping  

When preview grid snapping is enabled, objects close to a grid line will snap to it when you are 
moving or resizing an object. 
To toggle snapping on/off, click on the preview grid snapping icon beneath the preview 
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Editing - Onion Skin (Keyframe Overlay)
Onion Skin  
The term onion skin in computer graphics is also referred to as keyframe overlay. You can 
locate the onion skin under the canvas
panel. It is positioned on the left side of the show grid button. 

Once 
the onion skin has been toggled, the effect will automatically be activated on the shapes and 
drawings within the canvas

panel.
With the onion skin toggled upon playback, you can see that the previous keyframe associated 
with the object will appear as a
translucent version of the element on the succeeding keyframes. 
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Drawing Tools - Rectangle
Rectangle 
The rectangle tool allows you to draw a rectangle. Simply click and hold down the mouse, drag 
until you get the size of the rectangle you want, then release the mouse button. 
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Drawing Tools - Ellipse
Ellipse 
The Ellipse tool allows you to draw a circle or ellipse. Simply click and hold down the mouse, 
drag until you get the size of the ellipse you want, then release the mouse button. 
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Drawing Tools - Custom Shape
Custom Shape 
The Custom Shape allows you to create your own shape. 
To draw a custom shape: 

* With the Custom Shape toolbar button selected, click in the Canvas where you want to 
place the first vertex.
* Click where you want to place the next vertex to create a straight segment.
* By continuing to click, you create a path made of straight line segments connected by 
corner points.
* To create a curved segment, click and drag the direction line handle to create the curve 
that you want.
* To finish editing press the Enter or Escape key.
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Drawing Tools - Pencil
Pencil 
The pencil tool allows you to draw on the screen and produce a pencil-like stroke. The current 
Brush Color will be the color of the drawn path. 
The Brush Size option allows you to specify how wide of a stroke is drawn. 
The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get). 
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Drawing Tools - Line
Line 
The line tool allows you to draw a straight line. Simply click and hold down the mouse, drag 
until you get the line you want, then release the mouse button. 
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Drawing Tools - Poly Line
Poly Line  
The poly line tool allows you to draw a freeform series of connected lines. Simply click each 
location where you wish to have a line endpoint. When you're finished, you can either double 
click the first endpoint or press the Escape or Enter key. 
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Drawing Tools - Bezier Curve
Bezier Curve 
The bezier tool allows you to create curves with the highest possible precision, by manually 
selecting the points, and the bezier control points that determine how "curvy" the path is. 
After selecting this tool, simply click to create the first point of the curve. Each point you create 
will be connected to the previously place point in the order they were created. If you press and 
hold the mouse button down, the point will be placed where you first pressed the button while 
the position of the control points will be determined by the position of the cursor when you 
release the mouse button. 

You can move any point that's already been placed by dragging it to a new position (the bezier 
points will maintain the same relative positioning), and after selecting a previously place point 
(click to select it) you can individually adjust the bezier points also. You may delete a point at 
any time by right clicking on it to show the context menu. 
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Image Settings - JPEG Compression Settings
Quality 

Choose between a smaller file with lower quality, or a larger file with higher quality. 
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Image Settings - BMP Encoding Settings
Pixel Format 

Choose between a file with 8, 24 or 32 bits per pixel. You must select 32 bits per pixel if you 
wish to have any transparency in the picture. 
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Image Settings - PNG Encoding Settings
256 color 

You can check this option to 256-color palette PNG which is smaller than true color PNG. 
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Image Settings - PNM Encoding Settings
Portable Anymap Format 

Choose either monochrome (portable pixmap), grayscale (portable graymap) or RGB 
(portable bitmap) format. Each of them can be saved as plain (ASCII) or binary files. 
Binary threshold 
Set the threshold for converting image to binary image. It is only used with monochrome 
formats. 
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Image Settings - TIFF Encoding Settings
256 color 

You can check this option to 256-color palette TIFF which is smaller than true color TIFF. 
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Image Settings - JPEG 2000 Compression Settings
Lossless Compression 

Saves the image without any reduction in image quality, but results in a larger file than lossy 
compression. 
Lossy Compression 
Saves a smaller file than lossless compression, but causes some reduction in image quality. 
Quality 

Choose between a smaller file with lower quality, or a larger file with higher quality. 
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Image Settings - WebP Compression Settings
WebP is a new image format developed by Google and supported in Chrome, Opera and 
Android that is optimized to enable faster and smaller images on the Web. WebP images are 
about 30% smaller in size compared to PNG and JPEG images at equivalent visual quality. 

Lossy Compression 
Saves a smaller file than lossless compression, but causes some reduction in image quality. 
Quality 

Choose between a smaller file with lower quality, or a larger file with higher quality. 
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Image Settings - SVG Encoding Settings
Scalable Vector Graphics (SVG) SVG is developed and maintained by W3C SVG Working 
Group. It is a popular format for charts, illustrations and 2D graphics. It is a web-friendly vector 
file format.

Embed Image  
Retains the quality of image and converts into SVG format like XML
Convert to traced SVG (used in electronic cutting machine)  
The result is an outlined, black-on-white image. Common applications are for logos, t-shirt 
printing, etc.
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Image Settings - GIF Encoding Settings
Multi-page GIF (animated GIF) 

You can tick this option to create an animated GIF file. You can specify the delay of each 
frame by checking in the "Set frame delay in seconds" input box and putting a time delay.
Multiple GIF Files  
You can tick this option to create separate GIF files for each frame.
Check "Prompt when converting multi-page images"  if you want the GIF encoding settings 

to pop-up when converting multi-page images.
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Keyboard - Keyboard Shortcuts
Keyboard shortcuts available in the main window: 
Play Operations  

Space/F9 Start Playback at Current Speed Mode
F10 Play Normal Speed
F11 Play Slow Speed
F12 Play Fast Speed
Home Go to Start
End Go to End
Page Up Go to Previous Frame
Page Down Go to Next Frame
Esc Stop Playback
Ctrl+F9 Toggle Loop On/Off
Right Fast Forward
Left Rewind
Shift + > (greater than) Move to the next keyframe
Shift + < (less than) Move to the previous keyframe

 
Menu 

Alt Show full menu
 

File 
Ctrl+Alt+N New Project
Ctrl+O Open Project
Ctrl+S Save Project File
Ctrl+Shift+S Save Project File As
Ctrl+N New Composition
Ctrl+I Load Media File(s)
Ctrl+B Export Wizard
Alt+F4 Exit
 

Edit 
Ctrl+Z Undo
Ctrl+Y Redo
Ctrl+X Cut
Ctrl+C Copy
Ctrl+V Paste
Ctrl+A Select All
Delete Delete Selected Item(s)
Ctrl+Tab Switch to the next composition
F2 Rename Selected Item
Shift + + Increase brush size
Shift + - Decrease brush size
 

Canvas Editing 
Hold Shift + resize an object Keep current proportions
Hold Ctrl + click and drag a vertex Start a curve
Hold Ctrl + click and drag an object / anchor point Rotate an object / move anchor point
Hold Space + drag with the mouse Pan the canvas display
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Esc while editing text, mask, or shape Finish editing
 

Shapes and Other Tools 
P Pencil
F Fill
E Eraser
L Line
K Poly Line
Z Bezier Curve
M Custom Shape
A Rectangle
J Ellipse
T Text
 

Timeline 
Num + Zoom in
Num - Zoom out
Num * Show entire region
 

Record Audio 
Space Resume Recording / Pause
 

Help 
F1 Help Contents
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NCH Clipart Library - NCH Clipart Library
The NCH Clipart Library is a collection of hundreds of royalty-free images that can be added 
to your project. 
To open the library select 'Object' from the main menu or click 'New Object' button on the 
toolbar and select 'Add Images From NCH Clipart Library' or 'Clipart Image'. 
Use the panel on the left to select a clipart category. When a category is selected, a list of 
clipart images will be displayed in the center of the dialog. Click on any image in the list to see 
a preview on the right side of the dialog. 

When you find a clipart image you like, click the Download button. Once the image has 
finished loading, the clipart image will be added to your project. 
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NCH Sound Library - NCH Sound Library
The NCH Sound Library  is a collection of thousands of royalty-free sound effects that can be 
added to your project. 
Once you have opened the library, you'll see the following:

Folder Tree 
On the left hand side, each folder represents a category of sounds. Expand a folder to 
either see its subfolders or a list of sounds it contains. 
Sound List 
On the right hand side, all the sounds in the currently selected category are listed. This will 
be empty until a category is selected. 
Preview Sound  
Select a sound in the list then click the Play button to hear it. When you have finished, click 

. 
Download 
Select a sound in the list then click the Download button to download the sound (if it hasn't 
already been downloaded). 
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Screen References - Rename
Objects can be named to better organize your project. 
To rename a given object after its initial creation, right-click the object on canvas, timeline 
panel or in object tree and select Rename...  

Then change the name 
of the object in the dialog to a more appropriate and clik OK button. 
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Screen References - Welcome Dialog
The Welcome dialog shows when Express Animate starts and has options for creating a new 
project, opening an existing or sample projects, or reading the Getting Started guide. 
Uncheck the Show this dialog when Express Animate starts  check-box to prevent this 
dialog from showing again. To re-enable this option later, check Options -> Show the 
welcome dialog when Express Animate starts check-box. 
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Screen References - Missing Files Dialog
This dialog is used to replace missing files while loading a project. 
Every item in the list corresponds to a missing file used by the project. Double click a file and 
select a new file to use in its place. Missing files can also be resolved later by right-clicking an 
object and selecting File Source... 
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Screen References - File Source Dialog
This dialog is used to access information about the file source used by an object. 
Change file used by an object by clicking Change... button and selecting a new file. This could 
be used to replace missing files. Other parameters of the object (Name, Transform, Effects, 
Masks, etc) do not change. Sound file can only be replaced with another sound file. 

Information about the current used media file format is displayed in the Format field. 
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Screen References - Text Tools
Text Tools  While editing a block of text the text tools window will appear to allow you to 
change character attributes like font, character size and style for the selected text. You can 
also choose the text alignment for the block of text. 

 You can customize the attributes for selected characters.
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Font
This pull-down menu contains a list of fonts installed on your computer.

Style  
Depressing any combination of these buttons will change the style of your text to be Bold

Italic or Underlined. 
Font size 

This control adjusts the height of your text as a percentage of the frame height, from 1% 
to 100%.

Text alignment  
Selecting one of the alignment buttons will adjust the alignment of the text block within the 
frame. 
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Screen References - HTML5 Export
Select 'Save HTML5...' from the 'File' menu to save the active composition as a web page 
which can be opened in a web browser.
Please note that for all of the features to work properly the web page must be hosted on a 
web server and not opened as a local file. 
Basic settings
● Output folder - Output folder to save the web page and related files to.
● Resolution - Target resolution for the canvas HTML element the composition is rendered 

into.
● Number of times to loop the composition - The animation will stop after the specified 

number of loops. Set to 0 to run animation in a loop until the web page is closed.
Advanced settings 
● Codec settings - Select compression settings for every type of media during export.
● Save video objects - Select this option to allow output of the video objects. Animated 

effects and features which aren't supported by HTML5 must also be saved as video 
objects, otherwise they are discarded.

Please note that video objects might not work properly in mobile browsers.
● Save unsafe fonts as bitmaps - Select this option to save all text objects which use fonts 

that might not be supported on all platforms as image or video objects. Using this option 
might increase the output file size but makes sure text will look the same for everyone.

● Display 'Press to play' prompt when using video or sound objects - Select this to make sure 
playback only starts after user presses the canvas.
Please note this option must be enabled if you want to use video and sound playback in 
mobile browsers.
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Screen References - HTML5 Export Report
This dialog is displayed after the HTML5 export process has finished. 
Click the output folder hyperlink to go to the folder with the HTML web page and its related files.
It might not be possible to export some of the features into HTML5. If there were any problems 
during export, a special list is displayed. In the list for every object you can see its type, what 
happened to the object during export (Skipped, Modified, etc), and some details about the 
problem. Most of the problems could be fixed by enabling video objects export in the Advanced 
tab of the HTML5 Export Parameters dialog before saving the project as HTML5. But video 
objects might not work properly in mobile browsers. So the ideal solution is to remove or 
modify the objects with problems from the list.

Click 'Open Preview' button to start a built-in web server with the new HTML5 web page. The 
built-in web server's port number is specified in 'Port Number '. Default is 150.
You might need to confirm the Firewall exception for this feature to work properly. 
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Screen References - Composition duration dialog
This dialog is used to specify composition duration. The timecode corresponds to the total 
number of frames in the composition. Select 'Fit objects duration' to make sure the duration is 
set to fit the last frame of the last object on the timeline. 
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Screen References - Object duration dialog
This dialog is used to specify object duration. The timecode corresponds to the total number of 
frames in an object. 
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Screen References - Timeline position dialog
This dialog is used to select a timecode for the current timeline position. 
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Screen References - Custom aspect ratio dialog
This dialog is used to select custom aspect ratio for a composition. The aspect ratio describes 
the proportional relationship between width and height. 
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Screen References - Record Audio
Use Record Audio to record audio clips of any length, or when the audio does not (yet) need 
to be synchronized to video. 
To begin, select Object -> Record Audio, or click the button next to the Sound Library  
button on the tool bar and select Record Audio. 

Select the 
audio device and input channel to capture from. Type in a file name for the recording, and click 
the destination folder browse button if you want to save somewhere other than the default 
folder. 
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Click the Record  button to start recording. The duration of the recording and the current audio 
level are shown. Click the Stop  button to stop recording and add the recorded file to the 
current project. To record additional clips, click Record  again. 
When you are finished recording audio clips, click Close to close the dialog. 
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Screen References - Sample Projects
Project Samples 
Project samples are Express Animate projects that follow a theme and shows the possibilities 
of animation. To load a project sample, open the Samples Dialog  using the following action: 

● Select File -> Load Project Sample...  from the main menu. 
Click on a project to open it and start working. 
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Screen References - Color Picker Dialog
Color Picker Dialog  
The color picker is divided into multiple parts, with several ways available to choose a color: 
Visually Adjusting Color  

The top half of the dialog consists of 2 colored boxes, one that lets you pick any point in a 
256 x 256 square and the other that works as a long slider. Which colors are displayed in 
these two boxes depends on which radio button is selected (see below), but in all cases the 
position of the slider will change the colors available in the square box. Which ever point is 
selected in that square box is the selected color. 

Adjusting by RGB or HSV 
Underneath the square colored box, there is a series of 6 options (1 each for hue, 
saturation, value, red, green, and blue) that each contains a radio button, a slider, and an 
up-down number control. If one of the 3 HSV radio buttons is selected, that value will be 
represented by the visual slider (see above) while the other two values will be the axes of 
the square color box. The controls work the same way if one of the RGB radio buttons is 
selected. You can also adjust these values with the sliders provided next to the labels, as 
well as the up/down controls next to the sliders. Any adjustment of these values will update 
the visual controls, and any adjustment of those visual controls will update these values. 

Selected Color 
The selected color is displayed to the right of the RGB and HSV controls. The box is split 
diagonally, with the upper left section labeled New (the color you are creating), and the 
bottom right section labeled Current (the color that already exists, and will continue to be 
selected if you Cancel the dialog). Beneath that is the Hex Value of the selected color (you 
can also enter any valid hex value there to update the selected color). There is an 
eyedropper button to the right of the selected color that will allow you to set the selected 
color by sampling anywhere on the desktop. 

User-defined Color Palette  
At the bottom of the dialog you will find a series of 12 colored rectangles alongside a button 
titled Set to Swatch. These comprise the user-defined color palette, and allow you create 
and save (these will persist even when Express Animate is closed) your own custom colors. 
To set a swatch's color, first select that swatch by clicking it. Then choose your desired 
color, and finally click the Set to Swatch button. You can then load any of the saved colors 
by simply clicking on that swatch. 
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Screen References - Custom Resolution
This dialog allows you to set up the resolution for your video during saving. To set a custom 
resolution, click the Save button on the toolbar and select the Disc: Make Data Disc, 
Computer/Data, Portable Device, Image Sequence, or Stereoscopic 3D options. From the 
Resolution drop menu, select Custom.

In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
If Keep aspect ratio checkbox is available, you can check it to retain the same aspect ratio 
when changing the width or height. 
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Screen References - Custom Resolution 
(360-Degree Video)
This dialog allows you to set up the resolution for your 360-degree video during saving. To set 
a custom resolution, click the Save button on the toolbar and select the 360 Video File option. 
From the Resolution drop menu, select Custom.

In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
The width must be exactly double the height for 360-degree videos.

86



Screen References - Custom Frame Rate
This dialog allows you to set up the frame rate (number of frames per second) for your video. 
To set a custom frame rate, click the Save button on the toolbar and select either of the Disc: 
Make Data Disc, Computer/Data, Portable Device, or Stereoscopic 3D options. From the 
Frame Rate drop menu, select Custom.

In the Custom Frame Rate dialog that opens, input the frame rate and click OK.
The default frame rate is Variable Frame Rate (VFR)  but the dialog allows the user to select C
onstant Frame Rate (CFR)  by selecting the Constant frame rate checkbox.
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Screen References - Detected Format
This dialog shows you the detected format of the video sequence during the saving process. 
To detect the format of your video, click the Export Video button on the Home tab bar and 
select either of the following options: Video File, 3D Video File, Portable Video, Lossless 
Video, DVD Movie Disc, DVD Data Disc, Image Sequence, YouTube, Flickr, Dropbox, Google 
Drive, OneDrive, or Vimeo.

Click the Detect button next to the Preset field. Detect will adjust the video output resolution 
format based on your monitor screen size.
If you want to use a different format you can select the format from the Preset drop-down list.
Click OK to use the selected format as the output format.
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Screen References - DVD Bitrate Settings
This dialog allows you to specify bitrate for your DVD video. To open this dialog, click the Save 
icon in the toolbar and select the Disc save option and click the Make DVD Movie option. Click 
the Advanced button to open the DVD Bitrate Settings dialog.

The default option is to calculate the bitrate automatically. To set the bitrate manually, select 
the manual option and adjust the video and audio bitrates.
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Screen References - GIF Encoding Settings
Looping
Select this to get your GIF repeat itself endlessly.
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Screen References - Select Stream
Select an audio stream Audio Stream: 
Select an audio stream from the file
Don't ask me again 
Suppress the popup dialog to select audio stream
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Screen References - Speed Change
Use Speed Change to play an object faster or slower than normal and / or to play it in reverse. 
50% is half normal speed, 100% is normal speed, 200% is twice normal speed, etc. 
To change object speed, right click it and select Adjust Speed... 
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Screen References - Composition List
This dialog is used to add compositions as objects to the active composition. 
Select a composition from the list by clicking on it, then click the Add  button. You will see the 
composition appear in the tree view of the objects panel of the active composition. You can 
continue to edit the nested composition by selecting it from the dropdown list in the Objects 
Panel and making it the active composition. 
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Screen References - Options ~ General
Here you can setup memory usage parameters, choose the rendering method and enable 
smooth bitmap scaling. 
Cache and preview memory  
● Maximum amount of RAM to use for preview (MB) - The maximum amount of memory that 

could be allocated to store the composition cached frames. More memory allows longer 
fragment during cached preview playback.

● Maximum amount of RAM to use for cache (MB) - The maximum amount of memory that 
could be allocated to store cached frames for objects. More memory allows more objects to 
be used in a composition. Express Animate will display a warning icon if it runs out of 
memory.

Rendering method  Here you can choose a canvas rendering method. Hardware (OpenGL) 
should generally work faster, but might not work properly on some systems. 
Smooth bitmap scaling  When this option is enabled bitmaps use smooth bilinear 
interpolation when scaled. Otherwise nearest neighbour scaling is used.
You can enable this option individually for preview and video export. Please note that enabling 
this option decreases performance. 
Preview grid  Here you can set the grid cell size in the range from 1 to 100. Smaller cells allow 
you to more precisely place objects.
Grid and snapping to it can be enabled using the corresponding buttons on the canvas toolbar. 
Show the welcome dialog when Express Animate starts Select this if you want a welcome 
dialog to be displayed when application starts. The welcome dialog allows you to choose a 
project to start with and a link to the 'Getting started' guide. 

Show the playback mode selection dialog when adding an object with sound Select this 
if you want ExpressAnimate to request a playback mode switch when adding an object with 
sound. 
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Screen References - Options ~ Export
Here you can adjust settings related to the exporting of animations.
Burning 

To make changes to disc burning process you can adjust the settings by selecting one of 
the following options below.

● When the selected disc already has data, erase and replace it with my video
● Verify data after burning
● Eject disc when burning finished
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Screen References - Options ~ Disk
Here you can select the destination folder for cache and converted video files, and set the 
amount of kept cache. 
Cache 
● Cache folder - Specify a folder where you want to store cached data. Make sure you have 

enough free space available in the folder.
● Keep recently used cache files when Express Animate exits (MB) - Keeps the specified 

amount of recently used cached files on disk, to speed up media loading next time you use 
Express Animate.

Save converted video files to  Some of the video files have to be converted in order to use 
them in Express Animate. This is done automatically, and here you can select a folder to save 
converted video files to. 
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